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Virtual Appliance Installation and
Setup

% NOTE: Custom icons at this time only work with the Devon IT Terminal Operating
System (DeTOS) terminals, not Windows-based terminals.

This administration manual outlines how to install, setup, and run Devon IT
Echo Management Console Dell Edition. Required components include:
1 One or more thin clients
2 Echo enabled thin client
3 System running VMware Server, VMware player, or VMware vSphere.
4 System running DNS and DHCP servers

Download and Install vSphere, VMware Server,
or Player

Download and install the vSphere Client, VMware Server, or VMware Player on
a dedicated system. If you need assistance installing VMware, please visit
vmware.com.

Download the Echo Software

In order to download the latest Devon IT Echo Management Console Dell
Edition software to manage your Dell OptiPlex FX130 and FX170 systems,
follow these steps:

1. From a web browser, navigate to
http://support.dell.com/support/downloads/

Select Choose from a list of all Dell products.
Click Desktops=>Optiplex=>FX170->Confirm
Under Operating System, select DeTOS or Windows Embedded.

ok~ wbd

Under Applications, download the Echo Management Console Dell
Edition.
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If you have downloaded the .ova file version, continue on to the Install Virtual
Machine Setup with the vSphere Client section.

Install Virtual Machine Setup with the vSphere
Client

To start an Echo virtual machine with vSphere:
1 Launch the VMWare vSphere Client.
2 Enter the IP address of your ESX server and login credentials, then click
Login.
%) ¥Mware vSphere Client

vmware

VMware vSphere”

(lient

Ta directly manage a single hast, enter the IP address or host name.
To manage multiple hosts, enter the 1P address or name of &
wienter Server,

1P address [ Mame: |10.0.15.125 ﬂ

User name: ||

Password: I

™ Use Windows session credentials

Login I Close | Help |

3  Select Inventory to display the inventory of your ESX server.
4  Select File>Deploy OVF Template...
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10

Select Browse to navigate to the OVA that you have downloaded from
the Dell website and click Next.

2 Deploy OVF Template =l

Source
Select the source location.

Source
ONF Template Detals
Name and Location
Disk Format
Ready to Complete
Deploy from = file or URL

[Wesclient\iskidiskidel-echo-4.0-2011,12.01-esx ova R ET |

Enter a URL to download and install the OVF package from the Internet, or
specify a location accessible from your computer, such as a local hard drive, 2
network share, or a COfDVD drive.

el < Bark, Next > Gancel

YA

Select Next on the OVF Template Details screen

In the Name and Location screen, rename the template if needed. After
doing so, click Next.

Select the preferred format for your appliance in the Disk Format screen
and click Next.

Review the options on the Ready to Complete screen to ensure the
settings are correct. Select the Power on after deployment box if you
would like the machine to start after the installation. Click on Finish.

After the template has been installed, select it from the inventory list on
the left hand side. If you did not select Power on after deployment, you
must click the Play button above the inventory list.
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11 Select Console tab in the vSphere Client main screen to continue the
initial setup of the Echo Appliance Dell Edition.

51 10. Sphere Client [_[O[<]

File Edkt View Inventory Administration Ehugeins Help
=] ‘Q Home b g8 Inventory b [ Invertory
njp 8|t @ B|lE|e @ @

= [J 10.0.15.67
(03 DellEchn3.2.108.29

(33 DellEcho 4.0 12,01 #1
(5 DellEcho 4.0 12.01 #2
(5 DellECHO OvA

(33 DevonEcha 4.0 12.01 #1
(0 Devon Echo 4.0 12.01 #2
( Echa3.205.05

7

Do you accept the terms of the EULA?

materials and workmanship under normal use for 90 days from the date
you receive them. This warrawty is limited to you and is not
transferable. Any implied warranties are limited to 30 days from the
date you receive the Softuare. Some jurisdictions do not allow limits
on the duration of an implied warranty, so this limitation may not
apply to you. The entire liability of Dell and its suppliers, and your
exclusive remedy, shall be, at Dell’s option, either (a) termination
of this Agreement and return of the price paid for the Softuare or (b)
replacenent of any media not meeting this warranty that is sent with a
return authorization number to Dell, within the 90 day warranty
veriod, at uour cost and risk. This linited warrantu is void if anu

Recent Tasks Name, Target or Status contains: = Clear X

Hame | Target | Status | Details | Tnitiated by | Requested Stark Ti... — | Stark Time | Completed Ti

VDI Blaster test AP Box #1
VDI Blaster tesk XP Box #2
VDI Blaster test %P Box #3

4l | 0|
P Tasks | [Evaluation Mode: 39 daps remaining oot/
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Install Virtual Machine Setup on VMware

In order to set up your virtual machine on either VMware Server version, you
must first convert the .ova file into a .vmx file format that VMware Server can
recognize. You can find a VMware file converter at
http://www.vmware.com/products/converter . Once you have converted

your .ova file to the .vmx format you can continue with the VMware Server
instructions that pertain to you.

VMware Server 2.0

To set up the virtual machine on VMware Server version 2.0:

1

Open your VMware Infrastructure Access Page.

From the toolbar, select Virtual Machine> Add Virtual Machine to
Inventory.

Expand the Inventory node to navigate to your Echo folder and double-
click the file called echo-x.xx.vmx.

Click OK.

On the VMware Infrastructure Web Access page, under the Inventory
panel, select echo-x.xx.

Depending on the amount of memory available on your host system, you
may need to adjust the allocated Memory from the default 512 MB to a
lower value.

Power on your virtual machine.

VMware Server 1.0.x

To set up the virtual machine on VMware Server versions 1.0.0 through 1.0.8:

Select Open Existing Virtual Machine.

Select File=>Open and navigate to the echo-x.xx.vmx . The virtual
machine default name is echo-x.xx. This is added to your Inventory
column.

Depending on the version of VMware Server, to adjust the amount of
memory given to your virtual appliance, you may need to select the
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Adjust the Allocated Memory or Edit virtual machine settings
options.

4 After selecting your Echo settings, click Power On next to the green
triangle.

VMware Player
To start an Echo virtual machine on VMware Player:

1 Launch VMware Player on your system and click Open a Virtual
Machine.

2 Select All Image Files from the dropdown menu.
Open the .ova file located in the Echo folder. Select Import.
4 Your virtual appliance will immediately begin booting.
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Echo Password and Time Zone Configurations

1 Turn on the Virtual Machine.

2  After the bootup process is complete, the Setting Password window is
displayed.

3  Enter a new password for the bwadmin account. This password is
required to log on to Echo.

1 Setting password |

Please enter a new password for bwadmin. This will set the web
password and the system password (eg for ssh)

% NOTE: There is no minimum character limit required when entering a new password,
and the password is case sensitive.. However, it is recommended that the administrator
creates a password of at least six characters using a combination of upper and lowercase
alpha-numeric characters.

4 Once a password has been entered, use the arrow keys to navigate to the
OK button and press <Enter> to continue. You will be prompted to re-
enter the password a second time. Press the OK button again.

5  Set the time zone for the Echo Virtual Appliance in the Geographic area
menu. Select your area from the list and press <Enter>.

Geographic area:

Africa T
Antarctica
Australia
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6  Alist of cities is displayed in the Time zone menu. Select a city located
in your time zone and press <Enter>.
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Echo Network Configuration

DHCP Configuration (Default)

The next screen is the Networking configuration menu. By default, Echo will attempt
to automatically acquire an IP Address from the Dynamic Host Configuration Protocol
(DHCP) on your network. This means that your IP address will be automatically
assigned every time you reboot the machine and restart your Echo virtual application. If
DHCP assigned your Echo an IP address properly, the fourth option will read Change
eth0 inet dhcp <ip-address> <subnet mask>. Otherwise the line will just show
Change eth0 inet dhcp and you will need to assign a static IP address to the appliance.

| Networking |

No changes
DNS viewrsedit resolv.conf
ViewsEdit ~etcsnetwork-interfaces

hange eth® inet dhcp 10.0.5.138 255.255.255.0

Clicking the Change eth0 option will allow you to make changes to your Echo’s IP
configuration. If no changes are necessary, and no further configuration is required,
select No Changes and press <Enter> to continue.

Static IP Configuration

If DHCP is not available on your LAN, then you must manually set a static IP
address for the Echo server.

1 Select the option Change eth0... from the Networking menu.

2 On the next screen named Configuring ethO... select the Static option
and press the OK button.

l Configuring etho !

Btatic - You need to specify each parameter

DHCF - Dymamically request from mnetwork
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Enter the IP address to use as Echo's static IP and press OK.
Enter the subnet mask and then press OK.
Enter the gateway IP address and press OK.

Confirm the new static settings. Select Yes to apply the new settings or,
select No to discard these changes.

7  After selecting Yes, the network interface will restart and you will be
presented Echo's Main Menu.

o 0 b~ W

Editing DNS for Static IP Configuration

When using a static address, you must edit the Echo server's resolv.conf file.
This file contains the IP address to your DNS server(s) as well as domain search
paths.

GMU nano 2.0.7 File: /setc/resolv.conf

1 From the main menu, select Reconfigure Networks.
Select DNS view/edit resolv.conf.

3 Using the editor, make sure your file contains at least the following two
lines: search <domain> and namesever <ip address>

Where <domain> is your domain name and <ip address> is the
IP address of your DNS server.
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4 Add more nameserver <ip address> lines as needed for each
additional DNS server you want to include.

5 Press <Control><X>, then Y to save changes, and then press Enter to
save the file.

6 Select No changes to return to the Main Menu.

The Main Menu

Once you have completed the initial setup process, the Main Menu screen is
your starting point for all future Echo modifications.

Echo Appliance Dell Edition

Main Menu |
Point your browser at http: //10 0.15.84 for the web interface
Press Alt-F1, Alt-F2 etc for other consoles (this is Alt-F8)

Set bwadmin p

Configure active directorg

Change timezone (America/New_York)
Change hostname

Enable ssh server

Reconfigure networking

Configure database
Restart Echo
Halt machine
View Server Status
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Main Menu Options: Reference Chart

Table 1-1. Echo Main Menu Reference Chart

Main Menu Items

Description

Set bwadmin password

Select this to enter a new password for
the bwadmin account

Configure active directory

Allows users to log into the web front
end using Active Directory credentials
via an LDAP query

Change time zone

Select this to change the server’s
current time zone

Change Hostname

Select this to change the hostname of
the Echo server. The default hostname
iSws-broker

Enable/disable ssh server

Select this to enable or disable the SSH
server. SSH is disabled by default.
You may wish to enable SSH if you
plan on accessing the command line of
the Echo server from another machine

Reconfigure networking

Select this to:
e  Modify Static Network settings
e  Enable/disable DHCP
e  Manually edit the local DNS file
(resolv.conf)

e Manually edit the
/etc/network/interface
s file.

Configure Database

The default database is SQLite. You may
choose to configure the external database
to use MS-SQL instead

Restart Echo

Select this to reboot the Echo server

Halt machine

Select this to shutdown the entire Echo
virtual machine

View Server Status

This option displays current status of the
server and web interface
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Final Configuration Steps

DNS Configuration
On your DNS server, create an entry for

ws-broker .<mydomain*>.<mytld*> that points to the IP address of the
Echo virtual machine. This allows the terminals to find the Echo server
automatically.

Where <mydomain> is your domain name and <myt1d> is the top level
domain. For example:

e ws-broker.myXyzConsulting.com
e ws-broker.HiTechSolutions.net

e ws-broker.development.org

Alternative Configuration for Environments Without DNS

If you do not have access to a DNS server, you can add the IP address of the
server to your thin client by following these steps.

Follow these steps on each thin client you want to manage with Echo.

1 Inthe System Tray, double-click Echo Agent.
2 Inthe System Information window, click Change Management Server.
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3 Enter the IP address instead of the domain name ws-broker and click
OK.

Echo Management

Management Status  Managed

Management Server  <ws-broker >

[ Change Management Server

UuIo 914352A9-D4EA-5F30-183C-6CB05B2E7930

Metwork Information

IP Address 10.0.15.82

MAC Address 00:E0:C5:30:20:23

Hostname WINDOWS-K141561

MNetwork Tools

System Information

Operating System WEST

Processor Intel(R) Atom{TM) CPUN270 @ 1.60GHz

Memary 1.99041 GB

DOM Size 3.91443 GB

Hardware Model OptiPlex FX 170
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Firewall Ports

Table 1-2. What Ports Need to be Open for Echo Functionality

Port Protocol Components Purpose
80 TCP Echo Server HTTP — Standard web port for the
Echo Web Ul
443  TCP Echo Server HTTPS — Secure (SSL)
communication over http protocol
50000 TCP Echo Server, Used by SOAP. This port needs to
Hosts, and be open on ALL devices within the
Terminals Echo environment.
Check Connectivity

Using a web browser, enter http://<hostname or IP of your Echo
Server> into your web browser address bar. You may have to bypass some security
warnings to access the login page. If the installation and setup was performed
successfully, the Echo Login screen is displayed.

@ Echo 4 | Sign In - Mozilla Firefox

P Echo 4 [Sign i
@ L [P00I5T5] 111005 750
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Additional Installation Steps for Advanced
Configurations

% NOTE: Please read the next two sections only if you are deploying more than one Echo
Thin Manage Virtual Appliance in the same environment. If this does not apply to your
environment, skip to Chapter 2, “Learning Echo Basics.”

Configure Devon IT Echo Management Console Dell Edition to Use
MS-SQL Database

By default, Echo is configured to use a single SQL.ite database that is internal to
the Echo virtual machine. Echo can also use an MS-SQL database, and must do
so when more than one Echo virtual machine is used. For example, if you plan
on deploying the Enterprise Architecture to take advantage of High Availability
features, then you must follow these steps:

1 Visit easysoft.com/member/login.phtml to register for an Easysoft
ODBC driver authorization code.

% NOTE: Be advised that Easysoft is not controlled by Devon IT or Dell. Any usage of
Easysoft products are the responsibility of the administrator to implement and
troubleshoot.

2 Select Configure Database from the Echo virtual machine's Main Menu
screen.

3 Click Select and configure a different database from the Database
Configuration menu.

4 Select mssql from the Select a Database menu.

5 Select Install Easysoft ODBC Driver from the Easysoft ODBC
Installation menu. This will launch the driver installation script.

6 Press <Enter> to read the end-user license agreement. Type Yes at the
first prompt to accept the license.

7 Keep pressing <Enter> until you see Running the License Application.
Choose option [2] from the menu.

8 Enter your Name, Company Name, and email address at the
appropriate prompts. The other questions can be left blank.

9 You will see How would you like to obtain the license? Select option
(11
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10

11

12

13

14

Select [0] Exit at the next menu.
Press <Enter> at each remaining prompt to use the default settings.

When you return to the mssql/ODBC configuration menu, configure the
database name, IP address, port, and username for your mssql
database.

When finished, choose Keep Current Settings to accept your settings
and return to the Main Menu.

Select Restart Echo from the Main Menu to activate the database
connection.

Configure Devon IT Echo Management Console Dell Edition to Use
MySQL Database

You can choose to connect to a MySQL database. To configure your
management server with your MySQL database:

1
2

Select Configure Database from the Main Menu.
Select Select and Configure a Different Database>MySQL.

Enter the appropriate values for the IP address, port, username,
password, and database fields that correlate to your MySQL server.

Select Keep Current Settings and select OK. Press <Enter>.

Select Restart Echo from the Main Menu to activate the database
connection.
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Troubleshooting a Bad Connection

Make sure that your Echo appliance has network connectivity and that data packets can
flow to and from the appliance. You can switch to a different virtual terminal, or try in
the appliance itself by hitting <ALT> and the right arrow key. Once at the terminal
prompt you will see ws-broker login: _.

You can log in using the username bwadmin and the password which was set during the
initial configuration of the Echo management server. Test network connectivity by
pinging remote machines to ensure the appliance can see machines out on the network.
Also ping your Echo server from a thin client to make sure the device can see the server.

If you are unable to ping to or from the server, double-check your network settings and
make sure that port 50000 is open on the network.
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Learning Echo Basics

Terminology

You should familiarize yourself with the following list of terms, as they are used
throughout this document.

e Terminal-This is the device to which the screen, keyboard and mouse are
attached.

e Session-This is a network connection between a thin client and a host,
with the display and USB components connected.

e  CMS-This is the Connection Management Server (CMS), which manages
connections between thin clients and hosts. The Echo Thin Manage
Virtual Application is a CMS.

e Cloning- This is a process of copying the profiles, settings, or images
from one terminal in order to make them available for application on other
terminals.
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Accessing the Echo Web-Based Interface

1 Using a web browser, type the following URL into the address
http://<hostname or IP of your Echo server>and
press <Enter>.

% NOTE: There is a security certificate warning that may appear when connecting to the
server. Click Yes to continue.

2 Enter bwadmin as the Username and Echo password set up during
installation. Press <Enter>. If Echo is properly configured, and DNS
settings are correct, you will see the Echo Administration Screen.

The Echo Administration Screen

The Echo Administration Screen is divided into three main sections. The left-
hand side displays the navigation bar with tabs. The central area of the screen is
where the various inventory tables are displayed, depending on which tab you
select. To the right of the screen is where specific information is displayed in
detail panes relevant to your selections in the table display.

The Terminals Table

The Terminals table is where you can view the individual terminals being
managed by the Echo software. Information such as the Name, Location,
Description, and many other details of each terminal can be viewed here.

Dell terminals and desktop access devices have a service called the Echo Agent
that communicates with the Echo managed server. The Echo Agent announces
its presence to the Echo server by continuously sending XML-based messages
known as “heartbeats,” which occur every 60 seconds by default. As the agent
heartbeats into the server, information about that device is displayed in the
Terminals table.
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http://ws-broker/
http://ws-broker/
http://ws-broker/

Terminals

© Add Terminals | | © Delete Selected

snow| 10 B0 enries search: O

Name Description Location IP Address ~ Last
SIDESWIPE 100.15.122 2011
00abbl31880616108b56e0567233¢085  John Smith's FX170 HR 1001531 201

100.15.49 201

100.15.49 2011

100.15.49 2011

100.15.49 201

Showing 110 10 of 1,490 entries. 2345 Next | Last

The Connections Table

Terminals have the ability to connect to remote servers utilizing various types of
protocols. The Connections table is where you can go to create, manage, and edit the
RDP, ICA, VDI, and other connections you have available.

The Profiles Table

A key function of the Echo software is the creation and application of Profiles
in order to effectively manage the settings applied to individual terminals
remotely. A profile can contain a wide variety of settings that can then be
applied to individual terminals as the user sees fit. The Profiles table is where
you can create, manage, and edit the profiles that are at your disposal.

The Disk Images Table

A Disk Image is a file that can be created in order to combine many different settings
and profiles into one complete package. While creating Profiles and editing Terminal
Settings provide ways to customize terminals, creating a Disk Image allows the user to
combine multiple profiles and settings packages, as well as an operating system, into a
single resource. Utilizing disk images can greatly simplify the management process.
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The Terminal Settings Table

Terminal Settings are the display, sound, keyboard, mouse, and password
configurations for that particular terminal. Administrators can use Echo to clone these
settings from one terminal, store them within the Echo Thin Client Settings database,
and then apply them to other terminals.

% NOTE: For more information on how to configure display, sound, keyboard, mouse, and
password configurations, please refer to your DeTOS, WES 2009, or WES7 guide.
Details on how to alter these settings, install MUI packs, and select languages can be
found there.

The Certificates Table

Certificates can be added into the Echo Management software and seen in the
Certificates table. These certificates can then be pushed down to terminals through the
Terminals table.

% NOTE: Certificates can only be used in this manner on thin clients that are running the
DeTOS operating system.

The Details Pane

Additionally, certificates can be incorporated into Profiles or Disk Images.When a
selection is made in any of the inventory tables, panes will open up on the right
hand side of the screen. Depending on what has been selected, these panes
allow you to make changes to different aspects of the selection. The available
options will be explained in more depth in their individual sections. The Name
and Details pane is the most common and is highlighted below.

Terminals

devon, im

Name Descripton© | Lacasan P Asaress Lastc | % Mame and Detats
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% NOTE: You can select more than one object in the various tables. Press the <Ctrl> key
and left-click on choices in the table to add individual terminals to the selection. Hold the
<Shift> key and left-click on the options in the table to select every terminal between the
two items that you have selected.

The Context Menu

Right-clicking a highlighted selection the Terminals table displays a Context
Menu with various actions that can be performed on that selection. A context
menu item that has an arrow beside it indicates that sub-menu options are
available for this action. The context menu is the main menu where Echo
Administrators will be applying changes to terminals.

® Certificate
® Connection
® Disk Image

® Profile

® Terminal Settings
® Execute a File

® Reboot Terminal

® Update Echo Agent

® VNC Shadow

Searches

The Search bar, located on the upper right-hand side of each inventory table,
allows you to search that table for specific information. A search scans all
possible fields in each inventory table, so it is possible to narrow the visible
items based on the specified criteria. Finding terminals that share a common IP
address, have the same model type, or use the same profile are a few of the
many uses of this function. For example, if an administrator has to perform an
update on all terminals running DeTOS, typing “DeTOS” into the search field
displays only those terminals in the inventory table. The administrator can then
perform updates with a more focused view of the terminals being managed.

As information is entered into the Search field, the inventory table will
automatically update and display the items that match your search criteria.

i NOTE: Itis possible to narrow the results down to only focus on particular fields. For
example: to match the word "lab," but only in the location field, use location:lab.
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Terminal Management

Echo Agent Updates

The Echo Agent is a service that runs on terminal devices and communicates
with the Echo server. Periodically, Dell releases new Agent setup programs that
provide additional functionality. This section outlines the steps for updating a
new Agent to your inventoried terminal using the Echo software.

Where to Download the Latest Echo Agent

Visit support.dell.com to locate and download the latest Devon IT Echo Agent
software used for communicating your OptiPlex FX130 and FX170 thin clients
with the Devon IT Echo Management Console Dell Edition software.

How to Update the Echo Agent on Your Terminals

1 From the Terminals table, select the terminal or terminals that need to be
updated and right-click on a selected terminal to view the Context Menu.

2 Select Update Echo Agent in the context menu.

3 The Name and Details pane on the right-hand side displays the terminal
name(s) you are about to update. Click the Choose File button and
navigate to the new Echo Agent Setup executable downloaded on your
local system.

+ Upgrade Echo Agent

You are updating the Echo agent on;

Download from URL
File
/tmp/detos-agent-2011-11-1 | Browse...
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4 Click Submit to enter your changes.

The message Echo agent request sent is displayed. The new
agent begins installing itself on the actual device. This may take 30-60
seconds. Once this installation has finished and the new agent heartbeats back
to the Echo server, the Agent Version column for that terminal displays the
new version number. The image below shows the Agent Version column.

show| 10 5| erwries e 7

r

Agent Version Hostname MAC Address

3.2.1.20111129 181912 (00-E0-C5-3D-26-F5 O0E0:CS5:3D:26F5

Custom Icons

Administrators can use customized icons for individual connections. Using
DeTOS-based operating systems and the Echo software, administrators can
upload their own pictures through their web browsers. The uploaded image can
then be used as the desktop icon for all of the various connections on the DeTOS
Desktop. This section describes how to use your own images locally as Desktop
icons.

4 NOTE: Custom icons at this time only work with DeTOS terminals, not Windows-based
terminals.

How to Upload an Image
1 Under the Maintenance tab, select Icons.
2 Above the Icons inventory table, select Add Icon.

3 Type a name in the Name field in the Name and Details pane. This is
the alias that Echo will give the image you are uploading. This can later
be attached to different connections.
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4 Use the Choose File button to launch a window that will allow you to
explore your local machine to find an image to upload. Highlight the
image and select Open.

Add Cancel

+ Name and Details

Name

¥ lcon Upload

lcon
| Browse... |

5 Click the Add button at the top of the Name and Details pane. An
“Icon Added” message is displayed, and the new icon is immediately
displayed in the Icons inventory table.

How to Customize a Desktop Icon

Uploading the image into Echo is the first step to customizing your desktop
icons. Now we have to add the icon to connections. This can be done by
selecting the Connections tab in the navigation bar. To edit current connections,
follow this procedure:

1 From the table of inventoried connections, select the desired connection
to select it.

2 Inthe Name and Details pane, there is a dropdown menu labeled Icon.
Click on this to view the list of available options.

3 Choose the icon from the dropdown menu. It has the same alias as the
one given by the administrator during upload.
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4 After selecting the custom image, click Update above the pane to save

5

your changes.

Update Cancel

~ Name and Details

Name

Firefox

Local Display Name

Firefox

Description
00abbd3188c616108b56ed5cT233

Protocol

Firafox

Icon

inone i

In the Connections table a new icon is displayed on the left side of the
connection in the Icon column. All of the custom icons applied to
connections are listed in that column.
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Echo Cloning Overview

The following types of clones can be created using Echo:

Connections-Terminals have the ability to connect to remote servers
utilizing various types of protocols. The RDP protocol is used to connect
to Microsoft Windows Terminal Servers. The ICA protocol is used to
establish connections to Citrix servers. The VDI protocol, used by the
VMware View Client, allows a user to connect to a VMware View Server.
Administrators can use the Echo software to clone these types of
connections from one terminal, store them within their Echo Connections
database, and then apply them to other terminals.

Terminal Settings-Terminal settings are the display, sound, keyboard,
mouse, and password configurations for that particular terminal.
Administrators can use Echo to clone these settings from one terminal,
store them within the Echo Thin Client Settings database, and then apply
them to other terminals.

Profiles- Profiles are a way to combine multiple choices from both the
Terminal Settings and Connections configurations to create an
arrangement of options tailored to the needs of the user. Administrators
can use Echo to clone specific profiles to be applied to whichever
terminals require these combined settings.

Disk Images-The fourth cloning option that Echo offers is the ability to
clone the entire disk image of a terminal. A disk image includes
everything that is stored on the DOM on that terminal, including the
operating system itself. This does not include BIOS settings that have
been saved elsewhere. Disk image clones are inventoried and managed
by name within the Echo Disk Images database, but are physically stored
on an NFS share, CFIS, or FTP server on your local area network.
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Cloning Connections

Echo allows administrators to clone individual connections from a thin client
and save them in the Echo database. Administrators can easily create a
connection like VMware View or Citrix on a terminal and then propagate it to
all of their other terminals via a profile. All connections can be cloned, and the
most common are listed below:

e RDP- One or more .rdp configuration files used for connecting to
Microsoft Terminal Servers.

e |CA- One or more .ica configuration files used for connecting to Citrix
Servers.

e VMware- The connection settings and configurations for the VMware
View client.

e Firefox- The local web browser and its starting URL.

How to Clone Connections

1 From the table of inventoried terminals, select the terminal you want to
clone connections from and then right-click the selection to open the
Context Menu.

2 In the Context Menu, go to Connection->Clone from Terminal.

IO TS ST
® Cerificate
® Connection ® \iew Terminal
® Disk Image = Apply to Terminal
® Profile ® Clone from Terminal D}
® Termminal Settings ® Delete from Terminal
® Execute a File p—
10.0.15.49
® Reboot Terminal
® Update Echo Agent 10.0.15.48
® YNC Shadow
10.0.15.49
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3 The details pane on the right-hand side displays the available connections
you can clone from this terminal.

4 Under Connections, select one of the connections listed. To select

multiple connections, choose another from the dropdown menu and it will
be added to the list.

5 Click the Submit button. You receive a success message when the clone
is complete.

6 Inthe Connections tab, you can see your recently cloned connection
entry now in the inventory table.

Applying Connections to a Terminal

1 From the table of inventoried Terminals, left-click on a terminal and
then right-click on it to view the Context Menu.

2 Inthe Context Menu, go to Connection = Apply to Terminal .

In the Select Connections pane, select which connections you want to
apply from the dropdown menu. To select multiple connections, simply
choose another from the dropdown menu and it will be added to the list.

Submit Cancel

+ Apply Connections

You are applying connections to:

+ Select Connections

Connections:

Choose Connections... | ]

34 | Terminal Management



4 Click the Submit button. You will receive a success message when the
connection is applied.

Submit Cancel

+ Clone Connections

You are cloning connections from:
00abbd3188c616108b56ed5c72332085

Available Connections: 3

Connections

Choose Connections... =

When you apply connections to terminals, the actual ICA and RDP files are
saved under C: \Devon IT\Citrix and C:\Devon IT\rDesktop,
respectively. Shortcuts to these files are automatically created on the User and
Administrator desktops. The end-user can simply double-click these shortcuts
to initiate the connection.

& citrix
File

Edit View Favorites Tools Help

@Back * I? /—7 Search || Falders v

Address | [ C:\DevonITcitrix

Size  Type Dal
1KB Citrix ICA Client  2/1

A

File and Folder Tasks A

7 Make anew folder

€3 Pubiish this folder to
the Web

{ad Share this folder

Other Places
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% NOTE: There are a few differences in the way VMware View client connections are
handled by Windows, as compared to RDP and ICA connections. Only one VMware
View client connection can exist per user. The configuration settings for a VMware View
client connection are stored in the User account's registry hive, not in flat files like RDP
and ICA. This is simply the nature of VMware's View client program and not in any way a
limitation with Echo Thin Manage Virtual Appliance.

Cloning Terminal Settings

Echo allows you to clone the following terminal settings:

e Display-The screen resolution, color depth, and refresh rate of the
primary display device.

e Input-The keyboard and mouse settings.

e  Password-Configuration settings for the DeTOS Control Panel password
(DeTOS-only).

e  Sound-Settings for the master volume and mute control.
e  Time-Settings for the time zone.

e Agent Password-The password that has been set to access the DeTOS
control panel on that terminal.

e  Persistence-The settings for persistence that have been chosen for that
terminal.

¥4 NOTE: The Agent Password and Persistence settings are only available to be cloned
from terminals running DeTOS and do not apply to WES units.
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How to Clone Terminal Settings

1

From the Terminals inventory table, left-click to select the terminal and
then right-click to bring up the Context Menu. Select Terminal

Settings=>Clone from Terminal .

The details pane on the right-hand side will display a form with two
sections: Name and Details and Select Modules to Clone.

e Name-Enter a name for this clone. This name will be the name that

Echo refers to for these settings in the future.

e  Description-Enter a short description for this clone.

e  Terminal Settings Modules-Select the type of settings you would like
to clone. You can select as many options as there are in the dropdown
menu and the selected modules will appear in a list below.

+ Clone Terminal Settings

You are cloning terminal settings from:
00abbd318: 6108b56ed5c7

+ Name And Details

Available thin client settings modules: 7

Name

Mouse Setting

Description

Button Swap|

+ Select Modules to Clone

Terminal Settings Modules

® [nput

Click the Submit button. After a few seconds you will receive a success

message.

Open the Terminal Settings tab on the left-hand side. The settings you
just cloned should be listed in the inventory table now.

Terminal Management | 37



Applying Settings to a Terminal

1

From the Terminals inventory table, left-click to select the terminal and
then right-click to bring up the Context Menu. Select Terminal
Settings=>Apply to Terminal.

From the Terminal Settings dropdown list in the Select Terminal
Settings pane, select the saved settings clone you want to apply.

Optionally, if you would like to reboot the terminal after the settings have
been applied, then select the checkbox called Reboot after Applying. If
your new settings include network changes, then you may want to
consider enabling this checkbox. Otherwise, you may leave this box
unchecked.

In the list of modules, select which settings module you want to apply.
You can select as many options as there are in the dropdown menu and
the selected modules will appear in a list below. You must select at least
one module — even if it is the only one available.

Click the Submit button to apply these settings to your terminal. You
will receive a success message once they have been applied.

+ Apply Terminal Settings

You are applying terminal settings to:

+ Select Terminal Settings

Terminal Settings:

{FX170 Settings =]

Reboot after Applying:

+ Select Modules

Select Modules... | |
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Profiles

The profile feature in Echo allows you to assign terminal connections and
settings with one or more terminal. Profiles are useful for administrators that
wish to effect updates on many terminals at once. For instance, sometimes it
becomes necessary to change the details of a connection that is used for multiple
terminals. If a profile has already been applied to those terminals that contains
the connection details, simply updating the connection details in Echo will
automatically adjust the terminals to use these new settings. The next two
sections describe the necessary steps for creating and applying Echo profiles.

How to Create a Profile
1 Open the Profiles tab to be taken to the profile inventory table.

2 Left-click on Add Profile above the inventory table. Five detail panes
will open on the right-hand side.

e  Name-Enter a name for this profile.
e  Description- A description assigned to the profile.
e Mode-Select between the following profile application options:
e  Default Profile — Apply to ALL terminals on the Echo server.

e  Terminal Details — Apply to terminals by a specific detail such
as model, name, IP Address, or Operating System. This mode
overrides a Default profile. Opens the Terminal Details pane.

e  Select Terminals — Manually select terminals by name. This
mode will override both Default and Terminal Detail profiles.
Opens the Terminals pane.

e  Terminal Details-Specify which details to narrow down the profile
application by in the available fields.

e  Terminals-Choosing Select Terminals as the Mode allows the Echo
Admin to manually choose terminals in this box.

e  Connections-Assign cloned connections to this profile by selecting one
or more entries in the list. You may also choose to select none at all.

e  Terminal Settings-Assign cloned settings to this profile by selecting
one or more entries in the list. You may also choose to select none at all.
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e  Certificates-A Firefox certificate (to bypass Certificate download
warnings) can be exported from your Mozilla Firefox settings and
imported into a profile to bypass the warning. In Firefox, select
Options=>Options=>Advanced->Encryption-> View
Certificates=> Authorities.

e Disk Image: In the drop-down menu, if the Echo Administrator adds an
image to the profile, Echo will re-image the terminal every time it boots
if it doesn’t already have the specific image listed here.

3 Click the Submit button to create this profile. You will receive a success
message once it finished.

4 You will see your new profile entry now listed in the Profiles inventory
table.

Update Cancel

+ Name and Details

Name

FX170 Profile

Description

Input Settings & Connections

Mode
Select Terminals J

+ Terminals

Select Terminals

s
, 26d11075-2e7a- !
2802-b260-2ce6a0145948-1.1

+ Connections

+ Terminal Settings
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Applying a Profile

Once you finish creating a profile as described in the section above, it will
automatically apply the associated connections and settings the next time the
terminals included in the Mode are rebooted. However, if you would like the
changes to take effect immediately, then you may manually apply the profile by
following the steps below.

1 From the table of inventoried Terminals, left-click to select a terminal
and then right-click to open the Context Menu, and then select
Profile=>Apply to Terminal .

2 From the dropdown list of Profiles, select which profile you want to
apply.

3 Click the Submit button. You will receive a success message when it is
finished.

4 Connection shortcuts are automatically created on the terminal's desktop.
The end-user can simply double-click these icons to initiate the
connection.

Submit Cancel

* Apply Profile

You are applying a profile to;

Available profiles: 1

+ Select a Profile

Profiles:
Choose a profile... J
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Disk Image Cloning

Echo allows you to perform full disk image cloning of your terminals, utilizing
FTP, CIFS, or NFS protocols.

% NOTE: To create a disk image clone from a WES 2009 or WES7 terminal,
FBWF must be disabled. See the WES 2009 or WES7 Administration Guide

for instructions on how to do so.

How to Clone the Entire Disk Image

1 From the Terminals inventory table, left-click a terminal and then right-
click to open the Context Menu. Select Disk Image—>Clone from

Terminal.
2 The details pane on the right-hand side will display a Clone Disk Image
pane that contains a list of seven fields:
e Name-Enter a name for this disk image.
e  Description-Enter a short description for this disk image.

e  Protocol: From the dropdown list, select either “F TP, ” “CIFS,”
or “FTP”

e  FTP-Select this option if you will be using an internal FTP
server to store and retrieve Echo Thin Manage disk images.

e  CIFS-Select this option if you have a Local Area Network
(LAN) file-sharing CIFS server to store and retrieve Echo disk
images

e NFS-Select this option if you have an available NFS share on
a Linux/Unix server to store and Echo retrieve disk images.

e Image Location-Enter the protocol and location you will be using to
store your disk images.

:/‘ NOTE: You may use a hostname or IP address. Examples include:
ftp://myServerName/path/to/my/image/myImageName.img and
nfs://192.168.1.123/path/to/my/image/myXpeClone.img.
These above examples use .img extensions, but you may give it any extension
you want or none at all. Also, be sure to include the protocol prefix in the

location URL (ftp:// or nfs://).
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e  Verify Image-Select this checkbox if you want to perform an md5
checksum upon completion of the clone. Please be aware that the

cloning process will take much longer to complete when this checkbox
is selected.

e  Username-If required, enter the username of an account that has
permissions to read and write to the image repository you specified in
the Image Location field above.

e  Password-If required, enter the password needed for the Username
specified above.

Click the Submit button to begin the cloning process. This process may

take 20-40 minutes, depending on the size of the terminal's flash disk and
network traffic.

+ Clone Disk Image

You are cloning a disk image from:

UUUUUUUUUUUUUUUUUUUUUUU
Name

FX170 Image

Description

A Test Image

Protocol
File Transfer Protocol (ftp) =

Image Location

ftp:/10.0.5.11/images/test.img

Verify Image

Username

Password
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4 After completion, the newly cloned disk image can be seen in the
inventory table of the Disk Images tab.

Disk Images

@ Add Disk Image @ Delete Selected

show| 10 5| antries

Name Description Model Protocol

FX170 Image ATest Image ftp

Applying a Disk Image to a Terminal

% NOTE: When applying disk images to your terminals, be sure you are using the correct
image for that particular model, otherwise you may render that terminal unbootable.
Should a terminal become unbootable, a re-imaging guide can be found at
support.dell.com/support.

1 From the Terminals inventory table, left-click to select a terminal and
then right-click to open the Context Menu. Select Disk Image->Apply
to Terminal. To re-image more than one terminal at a time, hold down
the <Ctrl> key while selecting other terminals, or use the <Shift> key to
select a range of terminals.

2 From the Disk Image Name dropdown list on the Select Disk Images
pane, select the image file you want to apply.

% NOTE: Using the search function while performing disk image applications is advised.
For example, by searching for “FX170 DeTOS” will cause only FX170 terminals running
DeTOS to be displayed. By utilizing the search function, administrators can avoid
accidentally applying a disk image to a terminal of the wrong type or that is running a
different OS.
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3 Click the Submit button to begin the re-imaging process.

Submit Cancel

~ Apply Disk Image

You are applying a disk image to:

Available image files: 1

+ Select Disk Images

Disk Image Name:

Choose a Disk Image... j

Verify Image:

The terminal will reboot and begin re-imaging its flash media with the selected image.
This re-imaging process may take 20-40 minutes, depending on the size of the image
and network traffic. During this time, there is no agent to heartbeat into the Echo server,
and therefore the timestamp in the Last Contact field will remain unchanged. Once the
re-image is complete and the terminal does its final reboot, the agent will heartbeat into
the server, which in turn will update the Last Contact field. This update to the current
time in the Last Contact field is your cue that the re-imaging process is complete.
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Supplied Disk Images

New OS images can be added to your Devon IT Echo Management Console
Dell Edition inventory.

Visit support.dell.com to locate and download the latest DeTOS operating
system image for re-imaging your OptiPlex FX130 and FX170 thin clients.

% NOTE: Only the OptiPlex FX170 has the option to download and re-image the
Windows Embedded Standard (WES) operating system image, which is also
located at support.dell.com.

% NOTE: Make sure you download the proper image from support.dell.com. When
updating a disk image you will need to use partial disk images that contain only the
operating system portion instead of the full disk image that contains both the
operating system patrtition as well as the Update partition. These partial disk
images will be recognizable by the part1 found in the file name.

How to Add a Disk Image

1 Once you have downloaded the disk image from support.dell.com, copy
that image over to your FTP server or NFS shared directory.

2 From the Disk Images tab, left click on the Add Disk Image button
above the inventory table.

3 The detail panes on the right-hand side will display various fields used to
add the disk image.

e  Name-Enter a name for this disk image.
e  Description-Enter a short description for this disk image.
e  Protocol: From the dropdown list, choose your server:

e  FTP: Select this option if you will be using an internal FTP
server to store and retrieve Echo disk images.

e  CIFS: Select this option if you have a Local Area Network
(LAN) file-sharing CIFS server to store and retrieve Echo disk
images.

e NFS: Select this option if you have an available NFS share on
a Linux/Unix server.

46 | Terminal Management



e Image Location-Enter the location to where your disk image resides.

% NOTE: You may use a hostname or IP address. Examples:
ftp://myServerName/path/to/my/image/<name of dell disk
image>and nfs://192.168.1.123/path/to/my/image/<name of
dell disk image>.

e Username- If required, enter the username of an account that has
permissions to read & write to the image repository you specified in the
Image Location field above.

e  Password- If required, enter the password needed for the Username
specified above.

e Configuration File- If Toggle Import is on, click Browse to select a
Config file on your local machine. If Toggle Import is not on, fill the
following fields:

e Model-Enter the model name associated with this image™.

e  Operating System-Select the desired OS from the dropdown
menu.

Click the Submit button to add this disk image.

You will receive a success message. In the Disk Images tab, the
inventory table will now contain your recently added disk image. See
section titled, “Applying a Disk Image to a Terminal,” for instructions on
how to apply the disk image to your terminals.

+ Name and Details

Name

FX130 Image

Description
A Second Image
Protocol
File Transfer Protocol (ftp) J

Image Location

ftp://10.0.5.11fimages/test.img
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Maintenance

Backing Up Your Server

You can backup your server from the main Maintenance tab. The method used
is referred to as a 'Hotcopy' since the backup is created while the system is
running. There is no need to stop or suspend the Echo server for the backup. To
execute a Hotcopy, perform the following procedure:

1 Inthe Maintenance tab, open the Save/Restore Server Config
subsection.

2 Click on Save Server Configuration.

3  After selecting this option, the panel on the right-hand side of the web
interface displays the Save Hotcopy pane (pictured below) and lists
several checkbox options, along with OK and Cancel buttons. Select the
checkbox next to all of the Items, Logs, and Appliances you wish
to save in the configuration file and then click Save to start the backup
process.

~ Save Hotcopy

ltems

ol Terminals

o Configuration Settings
&l Connections

&l Client Settings

il pisk Images

ol Profiles

ol Certificates

il 1cons

ol Licenses
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The result of the Hotcopy will create a binary (.BIN) backup file that will
be downloaded to your local machine. Click Save File and make a note
of where you save this file, as you will need it in the future to perform a
restore.

Opening 20110804-1434-ws-broker-echobackup.bin

You have chosen to open
20110804-1434-ws-broker-echobackup.bin

whichis a: BIN file
from: https://10.0.15.120

Would you like to save this file?

Cancel

Server Restore

A restore deletes all existing configuration and data on your Echo Server and
overwrite it with the information contained in a previously created Hotcopy
backup file. To perform a restore, follow these steps:

1

In the Maintenance tab, open the Save/Restore Server Config
subsection.

Click on Restore Server Configuration.

After selecting this option, the Restore Hotcopy pane on the right-hand
side of the web interface displays will open. Under the Choose File
button, take notice of the Items to Restore, Logs to Restore, and
Appliance Settings to Restore categories and their respective options.

Click the Choose File button to search for the Hotcopy backup file on
your local machine. Double click the Hotcopy .BIN file to bring the file
path to the text box.

At this time, the administrator restoring the configuration file can choose
which settings (by category) to restore and which settings can be ignored.
Any settings that are not selected to be restored will remain as they are on
the current system setup.
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6  After the path to the backup file has been entered, click the Restore
button to begin the restore. Once the restore process is finished, you will
receive a Complete message in the information pane.

Restore Cancel

+ Restore Hotcopy

Hotcopy File

Iltems To Restore
&0 Terminals
] Configuration Settings
& connections
] Client Settings
o Disk Images
& profies
] Cerificates
] lcons
& Licenses
Logs To Restore
Device Logs
Echo Logs
Access Logs
Emor Logs
Appliance Settings To Restore
Timezone
Metwark Configuration
Enabled Services (ex. S35H)

Access List of Users & Passwords
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Appliance Upgrades

The following is the recommended procedure for upgrading your Echo
Appliance to a newer version.

1 Backup-Backup your server’s current configuration and data prior to
performing an upgrade using the Hotcopy procedure. Refer to section
“Backing up your Server” for details on this step.

2 Upgrade-

a. Shutdown the Echo Appliance Server (Select option 9, Halt
Machine, from the Main Menu).

b. Visit support.dell.com to locate and download the latest Devon
IT Echo Management Console Dell Edition appliance.

c. Extract the contents and point your VMware Server to the
new .ova file.

d. Restart the virtual appliance.

3 Restore-Once the upgrade is finished and the new appliance is back
online, restore your Echo Server. Refer to section “Server Restore” for
details on the restore process.
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Getting Help

Contacting Dell

For customers in the United States, call 800-WWW-DELL (800-999-3355).

Dell provides several online and telephone-based support and service options.
Availability varies by country and product, and some services may not be
available in your area. To contact Dell for sales, technical support, or customer
service issues:

1 Visit support.dell.com.

% NOTE: If you do not have an active internet connection, you can find contact
information on your purchase invoice, packing slip, or Dell product catalog.

2  Click your country/region at the bottom of the page. For a full listing of
countries/regions click All.

3 Click All Support from Support menu.
4 Select the appropriate service or support link based on your need.
5 Choose the method of contacting Dell that is convenient for you.
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